
About the Users Guide 
This Guide explains how to use the features of the SLA Communities of Practice (CoP) Web Site and connect 
with other members, information about upcoming events, access to important documents, and other useful 
information. CoP enables you to: 
 

• Create a Personal Page where you'll have instant access to the information YOU need 
• Join or request new, independent Communities of Practice focusing on topics important to you and 

other members of that particular CoP 
• Use the internal messaging system to communicate with other SLA members 
• Chat with other members on-line in "real" time  

 
Look for context-specific help found by clicking on the Help link within each section heading on site pages as 
well. 
 
We've segmented the information into two types: 
 

• Overview information. These sections cover the contents, features, and ways to use the major 
windows such as your Personal Page or a CoP page. 

• Step-by-step instructions. These instructions clearly walk you through a process such as changing 
your screen resolution. 
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SLA Communities Web Site Technical Requirements  
The following requirements are suggested in order for your Communities of Practice experience to be as 
valuable as possible. 

Minimum Requirements 

Operating System 

• Windows 95   
• Windows 98   
• Windows NT 4.0   
• Windows 2000  
• Windows XP 

Browser Software  

• Microsoft Internet Explorer version 6.0 or higher  
• Netscape Communicator version 6.1 or higher  
• SPECIAL NOTE FOR AOL USERS: AOL users should access the Internet through AOL, then open 

IE or Netscape to visit the SLA Communities of Practice web site.  

Checking for Required Browser Version 

Microsoft Internet Explorer 

1. Open your browser. 
2. Click Help on its top menu bar.  
3. Click About Internet Explorer. A popup window displays information about your browser. The 

version number is the first item listed.   

Netscape Communicator 

1. Open your browser. 
2. Click Help on your top menu bar.  
3. Click About Communicator.  A popup window displays information on your browser, including the 

version number.  

Upgrading Browser Software 
The more recent your browser version, the better you can take advantage of available features while using 
the Internet. Both Microsoft and Netscape maintain websites that provide free downloads of recent versions 
of their browsers.  
 
Note: Browser files are large and can take a long tome to download if you are using a dial-up connection.  

Microsoft Internet Explorer 

1. Go to http://www.microsoft.com/downloads. (If clicking this link does not work, copy and paste the 
address into your browser address box and click "Go." You will be taken to Microsoft's Download 
Center Home Page.  

2. Click the "Internet" link in the left frame. Because this is a popular download, it's usually listed in 
the "Most Popular Downloads" section at the top of the page. Click the link (As of this writing, the 
version available is Internet Explorer 6, Service Pack 1.) If you do not see it, use the drop-down list 
box below to select "Explorer" and then click "Go." 

3. Click the "Download" link (currently found on the right side of the page) and save the program to 
disk. 
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Netscape  

1. Go to http://channels.netscape.com/ns/browsers/download.jsp. (If clicking this link does not work, 
copy and paste the address into your browser address box and click "Go.") You will be taken to 
Netscape's Browser Download page. 

2. In the "Download Netscape Browser" (as of this writing, it's Netscape 7.1) box, click the Download 
button. 

3. You'll find a link to "Installation Instructions" directly below. 

Setting Your Browser to Accept Cookies 
Cookies are data files written to your hard drive by some web sites when you view them in your browser, so 
the server can identify you. A cookie is needed so that the CoP site can recognize you and open your 
Personal Page without needed to log in again. If you have your browser security setting at "high," you will 
not be able to view your page.  
 
You do not have to accept cookies in order to use the CoP site.  Cookies are used just as a convenience. 
 
If you are not sure if your browser is set to accept cookies or would like to change your settings, here's what 
to do: 

Internet Explorer 6.0 or higher 

1. Open your browser. 
2. From the menu bar, select Tools > Internet Options. 
3. When the Internet Options window opens, select the Privacy tab. 
4. Drag and drop the slider bar to Low.  
5. Click OK.  

Netscape 6.1 or higher 

1. Open Netscape. 
2. From the menu bar, select Edit > Preferences.  
3. In the left frame, Double-click Privacy and Security to expand the list.  
4. Click Cookies. Choose the Enable All Cookies radio button.  
5. Click OK.  

Deleting Cookies 
In some instances, you may need to delete your old cookies in order to login to the site. 

Internet Explorer 

1. Start your browser. 
2. From the top menu bar, select Tools > Internet Options. 
3. A pop-up window with Internet Options will appear. Under the Temporary Internet Files section, 

click on the Delete Cookies button. 
4. It may take a few minutes for your computer to delete all your cookies. Once the task is complete, 

click on the OK button at the bottom.  

Netscape 6.1 or higher 

1. Open Netscape. 
2. From the top menu bar, click on Tools > Cookie Manager > Manage Stored Cookies. 
3. The Manage Stored Cookies window opens.  

a. To delete all of your cookies:  
i. Click Remove All Cookies.  
ii. Click OK. 

b. To delete only the cookies related to the Communities of Practice. 
i. The View and Remove Cookies that are stored on your computer panel lists 

all cookies by site. Select the cookies related to cop.sla.org.  
ii. Click the Remove Cookie button. 
iii. Click OK.  
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Checking Your Operating System 
It's possible you'll need to contact technical support at some point with a question. You'll need to know what 
operating system and version your computer uses. To find out: 
 
1. From your desktop, right-click the My Computer icon. 
2. Left-click Properties. The System Properties window opens.  
3. System information appears on the General page.  

Pop-Up Blocker Software 
Some areas of the Communities of Practice web site use new windows to view information.  If you are using 
pop-up blocker software such as Pop-Up Stopper, Zero Popup, or similar applications from sites such as 
Google, AOL, or Earthlink, you will not be able to view some content.  The SLA web site does not deploy 
advertisements in pop up windows, and it is recommended that pop up blocker software be turned off while 
you are interacting within the CoP site. 

JavaScript and Java Applets 
The chat feature of the Communities of Practice web site uses java scripts and applets to execute the chat 
window. If you do not have the Java Plug-In already installed on your browser, you will see the following 
message and/or icon: 

Internet Explorer 6.0 or higher 

When Internet Explorer first encounters a web page that specifies Java Plug-in, Internet Explorer will 
open a message window and ask the user if it is OK to download an ActiveX control that is digitally 
signed by Sun Microsystems, Inc. and verifiable by the associated certificate.  
 

1. Click "Yes." Internet Explorer will quickly download a small ActiveX control from Sun's web site 
that will handle downloading the main Java Plug-in ActiveX control and Sun's JRE. This will 
include selecting the appropriate locale-specific JRE and offering the user a list of suitable 
download sites. It will then download the files automatically and install them.  

2. The Java Plug-in ActiveX control will then run.  
3. The next time Internet Explorer encounters a web page that specifies the Java Plug-in, Internet 

Explorer will seamlessly load and run the ActiveX control, requiring no user intervention. 

Netscape 6.1 or higher 

When Navigator first encounters a web page that specifies Java Plug-in, users will see a plugin-missing 
picture on the HTML page. 
  

1. Click on this picture to go to the Java Plug-in download page.  
2. Download the appropriate version of the Java Plug-in in accordance with your Operating System 

and install it.  
3. Java Plug-in will then run render the applet.  
4. The next time Navigator encounters a web page that specifies the Java Plug-in, Navigator will 

seamlessly load and run the plug-in, requiring no user intervention. 
 
If you are still having problems connecting to Chat, and are connecting to the chat from a company network, 
you may need to contact your IS department to let them know they need to open ports 7777 and 7877. This 
will allow you to connect to the chat. 
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Connecting to the Internet 
Connection Method Comments 
Dial-up modem with 
ISP (Internet Service 
Provider) 

Because dial-up access uses normal telephone lines, the quality of the 
connection is not always good and data rates are limited. The maximum data 
rate is about 56 Kbps (56,000 bits per second). 

ISDN Integrated Services Digital Network, an international communications standard 
for sending voice, video, and data over digital telephone lines or normal 
telephone wires. ISDN supports data transfer rates of 64 Kbps (64,000 bits per 
second). 

DSL Asymmetric Digital Subscriber Line allows more data to be sent over existing 
copper telephone lines. ADSL supports data rates of from 1.5 to 9 Mbps when 
receiving data (known as the downstream rate) and from 16 to 640 Kbps when 
sending data (known as the upstream rate). 

Cable Cable modems send digital signals on a cable network converting the signals into 
IP packets and routing the signals to an Internet Service Provide for connection 
to the Internet. Speeds vary but are about the same as a DSL connection. 

Corporate LAN (Local 
Area Network) 
connections 

T-1 lines are a popular leased line option for businesses connecting to the 
Internet and for Internet Service Providers (ISPs) connecting to the Internet 
backbone. The Internet backbone itself consists of faster T-3 connections. 

 
Note: If you experience performance problems such as slow loading pages when you access the SLA web 
site, it's important to know your connection type. If it's a dial-up, there is nothing we can do to increase 
performance.   

Changing Monitor Resolution 
The majority of web pages are designed for monitor set to a resolution of 800 x 600 pixels. Newer systems 
are likely to use higher settings. If you'd like to adjust the settings for your monitor, do the following: 
 
1. With your computer's desktop displayed, click the right button on your mouse. A popup menu displays. 
2. Select Properties. The Display Properties dialog box displays. 
3. Click the Setting tab. 
4. Click and drag the sliding arrow in the Screen area to adjust the resolution of your monitor. 
5. Click Apply; then click OK. Your monitor setting has now been adjusted. 
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Logging In and Out 
The system uses a login procedure to protect you and the system from unauthorized access. Logging in 
gives you access to custom information on your personal and community pages. 
 
1. In the Login field, enter your last name. 
2. In the PIN field, enter your password. Your default password is the PIN # found on your membership 

card. (You may change your password in your SLA member profile.) 
3. If you want this information to be automatically entered the next time you log in, click the Remember 

Me checkbox. (It is recommended that you don't choose this option if other people have access to your 
system.)  Note: Your browser must accept cookies for this function to operate. If you use Internet 
Explorer, go to Tools > Internet Options. If you use Netscape, go to Edit > Preferences. Choose 
"Accept all cookies." Your browser's help materials should provide detailed information or you can 
review the Setting Your Browser to Accept Cookies in the Technical Requirements section of this Guide.  

4. Click Login. Your Personal Page displays. Your personal page is an information center you can 
customize to meet your needs. 

Having problems logging in? 
If you attempted to log in and received a request to try again, you should: 
• Make sure you entered both fields correctly 
• Click Forgot your PIN? to have your password e-mailed to you. This works only if SLA has your current 

email address. 
 
If you have selected the Remember Me checkbox, you should: 
• Check to see that your browser is set to accept cookies 
• Delete cookies and try logging in again 

Retrieving a Lost PIN 
If you can't recall your PIN, you can have it emailed to you.  
 
1. Begin at the CoP Home Page. 
2. Click Forgot your PIN?. 
3. Enter the Internet e-mail address you have given to SLA. 
4. Click Submit. If the e-mail address matches the address SLA has on file for you, your password will be 

e-mailed to you.  
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Your Personal Home Page 

Setting Preferences 
To set the time to your local time zone: 
 
1. From your Personal Page, click Preferences, found on the top Menu bar. The My Preferences window 

opens. 
2. Click the down arrow in the drop-down list box to select the appropriate time zone. If your time zone is 

not available, select Other, then enter the appropriate number of zones between your time zone and the 
US Eastern time zone. (For example, if you are on Greenwich Mean Time, enter +5) 

3. Click Update.  Your time zone is set.  

Entering My CoP Profile  
If you'd like other SLA CoP members to know more about you, you can fill out your profile page and even 
add a photo. Others will be able to access your profile when you post a resource or a message to a 
discussion board. 
 
1. To create or edit your SLA CoP profile, click the My Profile icon (a Rolodex) found at the top of a 

community page or your Personal Page. 
2. You'll see 4 fields and a text box into which to enter information. Click into each of the fields and enter 

your first name, middle name, last name, and email address.  Note that the e-mail address entered in 
your profile will be used by the system to send notifications about communities you join and new 
messages waiting for you in the CoP internal messaging system.  You can use the text box to share 
more information about yourself with others in the community. 

3. Click the Browse button to upload from your computer a photo of yourself. Make sure the photo is in jpg 
or gif format and that the file size is 40KB or smaller. We recommend that your photo measure 150 
pixels wide and 180 pixels high. 

4. Click Update. This updates your profile and closes the window. 
5. You can view your new profile. Click the Personal Home tab to return to your Personal Page. 
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Moving Between Your Communities 

Accessing Your Communities 
The My Communities panel on your Personal Page links you to the communities of practice you have joined.  
 
1. To access a community, click the name of the community. The community page displays. 
2. To join a community, click on the Join/Visit Communities icon found at the top of your Personal Page. 

On that page you can either click Search to find a community based on a keyword or topic you are 
interested in or click on a letter of the alphabet to view communities whose names start with that letter.  
To view all communities at once, click on the View All link. After you have found a community that you’d 
like to participate in, click the check box next to the community you want to join, then click Join 
Communities button at the bottom of the page.  If you would like to review the community’s content 
before joining, click on the community name.  You will then be redirected to the community home page, 
with permissions to view only the content listed on the home page.  To participate in the community 
and/or view additional information found under the View All links, you must join the community. 

3. To remove a community from your list, click the Unsubscribe icon found at the top of your Personal 
Page. On the page which displays, click into the check box of community you want to remove, then click 
Unjoin button.  

 
To navigate directly to your other Communities from any Community Page without returning to your 
Personal Page: 
 
1. From any Community page, click the down arrow of the My Communities drop-down list box, found at 

the top of the left frame of the page. 
2. Select the community you want to view.  The new Community Page displays. 
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Working with My Links 
It's easy to add links to your favorite web sites to your Personal Page. 

Creating Categories for Links 
Links can be listed within categories.  You can create a "general" category if you do not wish to create 
multiple categories right away. Eventually you may want to organize your links into categories for easier 
navigation. 
 
1. Click Manage Links in the header of the My Links panel. The Manage Links window displays.  
2. Click Manage Categories link in the top right-hand corner of the page to create categories.  
3. Click on the New Categories link in the top right-hand corner of the page. The New Categories window 

displays.  
4. Enter a name for your new category and click Create Category. This adds the category to your list. 

Listing New Links 
1. Click Add Link in the header of the My Links panel. Or click Manage Links, then click New Links in 

the top right-hand corner of the page.  
2. The Add a Personal Link window displays.  
3. Enter the title you want to give the link.  
4. Type the link's URL address. (It's best to copy and paste this information for accuracy.) 
5. Click the down arrow on the drop-down list box to view and select the Category you want the link listed 

under.  
6. Enter keywords for the link that will help you find it at a later time. 
7. Enter a description of the link to help you remember its purpose.  
8. Click Submit Personal Link. The link will appear on your Personal page. 

Editing Links 
Use this function to edit information about existing links in your My Links panel. 
 
1. Click Manage Links.  
2. Click the Edit link to the right of the link you want to edit. The Edit Personal Link window displays.  
3. Make any needed changes to the information.  
4. Click Update Personal Link.   

Deleting Links 
1. Click Manage Links. The Manage Links window displays.  
2. Click Delete to the right of the link you want to delete. The link is deleted.  
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Using Search/Advanced Search 

Search 
The Search function is found at the top of the left frame on your Personal Page and all Community Pages. To 
perform a simple search:  
 
1. Enter a keyword in the text box. To search using more than one keyword, use "AND" between each 

keyword if you want to find results that include all of your keywords. Use "OR" between each keyword if 
you want to find results that include any one of your keywords. 

2. The system will search for phrases that match exactly what you enter. 
3. From your Personal Page, click either the My Communities (ones you have already listed on your 

Personal Page) radio button or the All Communities radio button.  From the community home page, click 
the upper radio button to search the current Community; click the lower radio button to search All 
Communities within the CoP site.  

4. Click Search. The Search panel opens, displaying a list of results ranked by probability score in the right 
frame.  

a. If you are a member of the community(ies) where results have been found, click any 
Community : Module link to go directly to the community page providing the result.  If you 
are not a member of the community where the resource was found, you must join the 
community in order to gain access.  You can immediately tell if you are not a member of a 
community when there is a Join link under the Community : Module name. 

b. If you are a member of the community(ies) where results have been found, click the 
Title/Summary link to go directly to the information. 

Advanced Search 
The Advanced Search function allows you to specify modules and specific communities to refine your search.  
 
1. Access Advanced Search by clicking the Advanced link on the Search header found at the top left frame 

of the CoP Home or Personal Page. The Advanced Search page opens. 
2. Enter your keyword(s) in the Keyword text box. To search using more than one keyword, use "AND" 

between each keyword if you want to find results that include all of your keywords. Use "OR" between 
each keyword if you want to find results that include any one of your keywords. 

3. Click the checkbox(es) underneath the module heading you want included in your search. The modules 
you can search include the following:  

 
Events 

• Title  
• Detail 

 
Frequently Asked Questions  

• Title  
• Answer  
• Keywords  
• Category Name  
• Community Name  
• First Name  
• Last Name 

 
Discussion Board  

• Name of poster  
• Title  
• Content 

 
Help  

• Website help information 
 

      Link 
• Title 
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      News  

• Title  
• Answer  
• Keywords  
• Category Name  
• Community Name  
• First Name  
• Last Name 

 
Polling 

• Name  
• Question  
• Answers 

 
Resources 

• Category  
• Keywords  
• Title  
• Resource  
• Content 

 
4. Select either All Communities, All My Communities, or Select Communities by clicking the 

appropriate radio button. 
5. If you've chosen Select Communities, click the down arrow on the drop-down list box and select the 

Communities you wish to search on.  If you would like to select multiple community names, press 
your control key at the same time you left-mouse click to highlight the community name.  You can 
select as many communities as you want using this method. 

6. Click Search.  Your search results display.  
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Event Calendars 

Viewing Upcoming SLA Events 
You'll find news of upcoming SLA events as the second category in the left frame of your Personal page. To 
learn more about an event: 
 
1. Click the link. The information displays in a new window. 
2. To print the information, click Print Event. Follow your printer's directions. 
3. Click the small "x" in the upper right corner of the window to close it.  

Viewing All SLA Events 

To view a complete list of SLA events: 
 

1. Click the All Events link.  
2. Click an event to view details. The events display in a new window. 
3. Click the small "x" in the upper right corner of the window to close it. 

Working with My Events Calendar 
You can track events important to you on your My Events calendar, found in the right frame of your Personal 
Page. 

Adding an Event to Your Calendar 
1. Click Add Event in the header of the calendar.  The Add Event window displays. 
2. Enter a title for the event. 
3. Enter the Start and End Dates or click Select and choose the date from the calendar which displays. 
4. Enter the start and end times of the event. 
5. Enter a description of the event helpful to you in the Details field. 
6. Click Update. The event is added to your calendar and you're returned to your Personal Page. 

To View Events You've Added to Your Calendar: 
1. Dates on your calendar with events are underlined and italicized. Click the date to view the details. The 

day's events appear on a new page. To return to your personal page, click the Back button of your 
browser or the Personal Page tab at the top of the page. 

2. To view all your events, click All Events at the top of your calendar. The All Upcoming Events page 
displays. To return to your personal page, click the Back button of your browser or the Personal Page 
tab at the top of the page. 

To Edit an Event on Your Calendar 
1. From your Personal Page, click either the calendar date of the event or All Events. 
2. From the page that appears, click on the event itself. A new window displays. 
3. Click Edit Event tab, found at the top left of the window. The Edit Event window displays. 
4. Enter your edits in the appropriate field(s).  Use the right scroll bar to scroll down the page.  
5. Click Update to save your edits. 
6. Click the small "x" in the upper right corner of the window to close it. 

Printing an Event from Your Calendar 
1. Begin with the event displayed in the Event window. 
2. Click Print Event tab, found in the middle of the window.  Your printer menu will display. Follow its 

instructions. 
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Deleting an Event from Your Calendar 
1. Begin with the event to be deleted displayed in the Event window. 
2. Click Delete Event tab, to the right of Edit Event tab.  The pop-up window requests a confirmation. 
3. Click Confirm: Delete Event tab. The window closes.  You will continue to see the event on the page 

until you refresh it (View>Refresh).  
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Suggesting a New Community 
If you can't find the community you're looking for under the All Communities Available list or one that 
matches a keyword that you’ve entered in the Search, use this function to request that the Community be 
formed. 
 
1. Click the Suggest a Community icon on the Top Navigation Bar or the Suggest a Community link in 

the header of the My Communities panel on your Personal Page. The Suggest A Community window 
displays.  

2. Click into the fields provided to describe the Community you want to request. Try to be explicit as you 
describe the benefits your Community would provide to SLA members. 

3. Provide one or more keywords to help potential members locate the Community in a search.  
4. Answer the Facilitator Questions.   
5. Click the down arrow of the drop-down list box and select the name of any Community to which your 

new community might be related, if applicable. 
6. Provide other relevant information that would help the SLA staff in reviewing your request in the text 

field below.  
7. Click Submit Suggestion. SLA staff reviews all suggestions for appropriateness and to avoid 

redundancy. You will be notified of their decision.   
 
Note: For a new community to be created, at least one facilitator must oversee activities.  As the person 
suggesting the new Community, you're the most obvious person to serve as Facilitator, or you may know 
someone who would like to serve. Facilitators are SLA members who volunteer to support and champion the 
success of a particular Community. These volunteers monitor activity within the Community, encourage 
member participation, and organize Community events (virtual or face-to-face). Duties of a facilitator 
include:  
 
• Starting discussions  
• Polling Community members  
• Updating content 
• Ensuring members' questions are answered 
• Coordinating member communications  
• Identifying and using experts  
• Scheduling and hosting chat sessions  
• Managing and organizing Community resources  
• Planning Community events beyond the virtual community 
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Polling 

Taking Part in a Poll 
The Poll (and alternatively, the Poll Results) you see on your Personal page are developed and posted by 
SLA staff.  The polls you see on the Community pages are developed by facilitators and community 
members.   
 
If a poll is available, it is displayed in the poll area. If you participate in the poll, the Poll panel displays the 
results of the poll (updated after you have voted) during the polling period.  To participate in a poll: 
 
1. Click on the appropriate response(s). 
2. Click Vote to register your response(s).  Current poll voting statistics display after the page refreshes. 

Submitting a Poll Topic 
If you have an issue you'd like to get membership opinion on, we encourage you to submit it.  Polls can be 
submitted on your Personal Page and all Community Pages of which you are a member. 
 
1. Click the Submit Poll link.  The Submit Poll window displays. 
2. Enter in the title for your poll in the text field. 
3. Enter your question and possible answers you'd like membership to choose from.  Question can be 

structure as multiple choice, scale, or yes/no. 
4. Click the checkbox if you want the participant to be able to make multiple selections. 
5. Click Submit Query.  SLA staff (for the Personal page poll) or your Community's facilitator (for 

Community polls) will review your poll for appropriateness and if accepted, will place it in the queue.  
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Notifications 

Notification of Community Activity 
If you've provided a valid email address in your Member Profile and have elected to receive notifications 
from either communities you are a member of or the internal messaging system, you will receive 
Community Notifications whenever something new has been added. (Click Profile Update to update or 
change your email address.)  
 
To receive notifications in the messaging system: 
 
1. Click the Messaging icon.  
2. Click the Mail Preferences tab at the top of the page. 
3. Select either the "Yes" or the "No" radio button to determine if you wish to be sent notification to your 

external Internet e-mail that you have received messages in your CoP mail account. 
4. Click Update to save your choice. The window closes. 
 
To receive notification from one of your communities: 
 
1. From any community page, click Notifications, found in the top menu bar. 
2. You will see drop-down list boxes allowing you to choose the frequency of notification of new items for 

Events, FAQs, Discussion, Link, News, Poll, and Resources. 
3. Select your preferred frequency of notification for the choices available to you (Don't Notify, Hourly, 

Daily, Weekly, Monthly, Immediately).  
4. Click Set Notifications. You'll receive email notifications according to the schedule you've selected 
5. Click the Community Home tab to return to your community  
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About the Facilitators 
Volunteer facilitators monitor community activities, encourage members to participate, and organize events. 
You can learn about these volunteers on the About the Facilitators page, where you'll find in most cases a 
short biography and photo, and a message link. 
 
1. Click the About the Facilitators link found at the top of the community's home page. The About the 

Facilitators page opens. 
2. Read the information. 
3. If you wish to contact the facilitator, click Send Message, located to the right of the facilitator's name. 

The Compose a Message window displays pre-addressed to the facilitator.  
4. Follow standard procedures for completing your message--enter a subject in the subject field and your 

message in the message field. 
5. Click Submit Message. The Folder : Inbox page opens with a message that your message has been 

sent. Use your browser back button to return to the About the Facilitators page, where you can click 
either Personal Home or Community Home as you choose. 
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Related Communities 
If the keywords entered by your community facilitators match other Communities, you'll find those 
communities listed in the Related Communities panel. Communities that you are already a member of will 
be linked; if you are not already a member and would like to visit a related community, click the Join/Visit 
Communities icon to explore these other communities. If there are several related communities, you'll find 
a View All link next to the Help link. 

Join a Related Community 
To become a member of a related community: 
 
1. Click the Subscribe link found to the right of the community name to join. 
2. The community will now appear on your My Communities panel on your Personal page and in your My 

Communities drop down on community pages.  It is also linked within the Related Community box. 

View All Related Communities 
To view all the communities related to your community:  
 
1. Click View All. You'll see all related communities. 
2. Click Subscribe links to join any of these communities or go to Join/Visit Communities to explore.  
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Chat with Peers 
Chatting is a way to communicate with your colleagues in "realtime." All members logged into a specific chat 
time or session can communicate back and forth by keying in their comments and reading others' messages. 
Productive chat sessions should be scheduled ahead of time, using the email and events calendar function, 
and have specific topics and moderators selected. 
 
To participate in a chat session: 
 
1. Click Chat With Peers on the Community page.  The Community Chat page displays.  The left column 

lists any individuals present.  Chat session text is found in the main text box. 
2. To participate, enter your comments in the line near the bottom of the window and click Send.  The 

screen refreshes to show your comment. 
3. Click Log off to end your session.  The page remains on the screen. The screen will no longer update 

with new comments.  Exit the page by clicking the Community Home link. Reconnect by clicking Log 
On.   

 
You can customize the look of the chat screen using the icons at the bottom of the screen to set your color 
preferences and to send icons with your text.  Bold and Italic icons are also available to enhance the text 
displayed when you submit your comment. 
 

Having a Private Chat with a Single Chat Participant 
To set up a private discussion: 
 
1. Select the participant's name from the left column list. 
2. Click the Private Chat button.  A Private Chat window pops up. 
3. Have your conversation. 
4. When you're finished, click Exit.  The window closes and you are returned to the group chat.  
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Using the Community Events Calendar 
The Community Events Calendar provides a month-at-a-glance of events scheduled for the current month.  
 
• Dates with scheduled events appear as links. 
• Click the previous and next arrows on either side of the date to view other month's calendars. 

Viewing an Event from the Community Page 
Events for the current month are displayed underneath the calendar. To access information about a specific 
event: 
 
1. Click its link. A pop-window displays the information. 

a. To print the information, click Print Event. 
2. To view all events, click All Events. 
3. Click the small "x" at the upper right of the window to close it.  

Viewing Events for a Specific Date 
Dates with scheduled events are shown as links (underlined and italicized). To learn what events are 
scheduled: 

 
1. From the Community page, click the date. 
2. The list of events displays. Click the event you wish to view in detail. 
3. Click Print Event to print the event. 
4. Click Community Home to return to the community page.  

Viewing All Events 
1. From the Community page, click All Events. 
2. The list of scheduled events appears. To learn more about an event, click the link. The information 

displays. 
3. To print the information, click Print Event. 
4. Click the small "x" at the upper right of the window to close it.  
5. Click the Community Home tab at the top of the page to return to the community home page.  
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Participating in Community Polls 
The polls you see on the Community pages are developed by facilitators and community members. 
 
If a poll is available, it is displayed in the poll area. If you participate in the poll, the Poll panel displays the 
results of the poll (and updates when you refresh the page) during the polling period. 
 
To participate in a poll: 
 
1. Click on the appropriate response(s). 
2. Click Vote to register your response(s).  Current poll voting statistics display. 

Suggesting a Poll 
If you have an issue about which you'd like community feedback on, we encourage you to submit it. 
 
1. Click the Submit Poll link.  The Submit Poll window displays. 
2. Enter in the title for your poll in the text field. 
3. Enter your question and possible answers you'd like membership to choose from.  Question can be 

structure as multiple choice, scale, or yes/no. 
4. Click the checkbox if you want the participant to be able to make multiple selections. 
5. Click Submit Query.  Your community's facilitator will review your poll for appropriateness and if 

accepted, will place it in the queue.  
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Viewing/Submitting Frequently Asked Questions (FAQs) 
The Community FAQ panel lists Frequently Asked Questions and answers grouped by category. The 
information is listed either in order of the most-asked questions or in order of the newest questions. Each 
question provides the author's name and date/time when submitted. Community Facilitators can move a 
FAQ to the top of the list if it is particularly timely. 

Viewing a FAQ Displayed on Community Page 
Community FAQs are found in the top panel of the page.  
 
1. Click the FAQ to view it.  The information displays. 
2. Click Community Home to return to the Community page.  

Viewing All FAQs for the Current Community 
There may be additional FAQs not viewable directly on the Community page.  To check for additional FAQs: 
 
1. Click View All. All questions display.  
2. Your viewing options include:  

a. Scrolling to view the full list  
b. Clicking the links at the top of the columns and re-sorting the by Category, by Author, by 

Number of Times Viewed, and by Date Submitted, depending on your needs.  
c. Clicking the drop-down list box to select and display FAQs in a single category.  
d. Clicking a single question. 

3. Click Community Home to return to the community page. 

Submitting a FAQ 
You can post questions and answers to the FAQ section of your community. 
 
1. Click Submit FAQ from the FAQ header on the Community page or the tab found at the top of the View 

All window.  The Suggest FAQ page displays.  
2. Chose a category for your FAQ from the drop-down list box.  
3. Enter appropriate keywords in the Keywords field to enable community members to locate your FAQ 

during a search.  
4. Enter your question in the Question field. 
5. Enter your answer in the Answer field.  
6. Click Submit FAQ.  Your FAQ suggestion will be reviewed and acted upon by the Community Facilitator 
7. Return to your Personal Home Page or to the Community Page by clicking the tab at the top of the page.  
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Viewing/Submitting Community News 
The Community News panel lists news items by category. Each news item lists the author's name and 
date/time submitted.  

Viewing News  
The number of news items shown on the Community Page is limited by available space, and only recently 
posted items are listed. To view an item:  
 
1. Click the news item link.  The news item displays. 
2. Click the Community Home tab at the top of the page to return to the community page. 

Viewing All News for the Current Community 
You can also view the entire list of posted news for a Community. 
 
1. Click View All. All new items display.  
2. Scroll to view the full list of news items or click the down arrow on the drop down list box to select a 

single category. 
3. Click the Community Home tab at the top of the page to return to the community page. 

Submit News 
It's easy to post news items you think might be of interest to other members of the Community. 
 
1. Click Submit News link in the header of the Community News panel, or the Submit News tab at the 

top of the page when viewing a news item or the View All page.   
2. Enter a News Title for your news item in the News Title text field. 
3. Select a Category from the drop-down list box. 
4. Enter appropriate keywords in the Keywords field to enable community members to locate your item 

during a search. 
5. Enter your content in the Content field.  A scroll bar appears on the right if the message is longer than 

the window.  You can use the tool bar in the content field to create italics, links, bolding, and so forth. 
6. Click Submit Community News.  Your news item will be reviewed and acted upon by the Community 

Facilitator. 
7. Return to your Personal Home Page or to the Community Page by clicking the appropriate tab at the top 

of the page. 
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Viewing/Submitting Community Links 
Community Links are links to other Web sites of interest to community members. Links listed in the 
Community Links panel are grouped by category. Each link shows the author's name and date/time 
submitted. 

Viewing Links 
To access a Community Link: 
 
1. Click the URL link. A pop-up window displays the Web site.  
2. Click the small "x" in the upper right of the window to close it. 

Viewing All Links for the Current Community 
To view the entire list of links: 
 
1. Click the View All link to display all links. 
2. To choose a link: 

a. Scroll to view the full list.  
b. Click the links at the top of the columns and re-sort the full list by Category, by URL, by 

Submitted By, and by Submitted On.  
c. Click the down arrow on the drop-down list box to select a single category to view. 

3. Click the link you want to explore. The site displays in a new window.  
4. Click the small "x" in the upper right of the window to close it.  
5. Click the Community Home tab at the top of the page to return to the community page.  

Submitting Links 
It's easy to post news items you think might be helpful to community members. 
 
1. Click Submit Link in the header of the Community Links panel or in the header of a link item. The 

Submit Link page opens.  
2. Enter your link's Title in the Title field.  
3. Enter the URL in the URL field. (Hint: It's best to copy and paste the link rather than to attempt to key 

it in.)  
4. Click the down arrow of the drop-down list box to select a category.  
5. Enter Keywords in the Keyword field to enable members to locate your link during a search.  
6. Enter a helpful description of the site in the description field.  
7. Click Submit Community Link. Your link will be reviewed and acted upon by the Community 

Facilitator. 
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Viewing/Submitting Community Resources & Best 
Practices 
Community Resources & Best Practices are documents members want to share with each other -- sample 
forms, guidelines, presentations, and so forth. The Community Resources & Best Practices panel groups 
these resources by category. Each link gives the file type, file size, author's name and date/time submitted. 
  
All files are automatically scanned for viruses before they are added to a Community and made available to 
other Community members.  Self-executable files (identified with a .exe file extension) are not permitted on 
the SLA CoP web site. 

Viewing Resources & Best Practices 
The number of resources shown on the Community Page is limited by available space, and only lists recently 
posted items. To view a resource: 
 
1. Click Resource. Your browser temporarily downloads the file to your hard drive, then opens it in a new 

window using the appropriate application. You can read, save, and/or or print the file as appropriate. 
2. Click the back button in your browser window to return to the CoP page.  

Viewing All Resources & Best Practices for the Current Community 
You can view the complete list of resources posted: 
1. Click the View All link found in the Community Resources & Best Practices header. All resources 

display. 
2. To view a resource:  

a. Scroll to view the full list. 
b. Click the links at the top of the columns and re-sort the full list by Title, Submitted By 

and by Submitted On. 
c. Click the down arrow on the drop-down list box to select a single category to view. 

3. Click the link to view the resource. Your browser opens it using the appropriate application.  
4. Click the back button in your browser window to return to the Community Resources & Best Practices 

page. 
5. Click the Community Home tab at the top of the page to return to the CoP home page. 

Submitting Resources & Best Practices 
It's easy to post resources you think might be of interest to community members. 
  
Note: Make sure you seek, gain and INCLUDE IN THE DOCUMENT permission for copyrighted materials or 
materials owned by your employer before posting and/or the source or owner of the document.  
  
1. Click Submit Resource in the header of the Community Resources & Best Practices panel or the 

Submit Resource tab at the top of the View All page.  The Submit Resource page displays. 
2. Click the down arrow in the drop-down list box to select a category. 
3. Enter your title in the Title field. 
4. Click Browse to locate and select the file you want to submit.  
5. Enter keywords in Keywords field to enable members to locate the file during a search. 
6. Enter an appropriate description of the file in the Description field. 
7. Click Submit Resource. Your submission will be reviewed by the Community Facilitator and acted upon 

as appropriate.  
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Participating in Community Discussions  
The Community Discussions panel on the Community page gives you access to ongoing discussions within 
the Community. These discussions are structured as follows: 
• Threads are overall topics of discussion, established by Community facilitators as a way of organizing 

topics.  
• A message or post is a comment made by an individual. A message can be the start of a thread or it can 

be a reply to someone else's message.  
 
The Community Discussions panel shows 
• Threads to which you have subscribed because they are of particular interest to you. You won't see this 

type if you haven't subscribed to any threads. 
• The most active threads within the Community. 
 
For each thread, you'll see information on the number of posts to the thread and its most recent update.  

Setting Discussion Preferences 
You can set preferences to view either a single message at a time or to view an entire thread. Here's how. 
 
1. Click the Discussion Preferences link on the Community Resources panel to access the Community 

Discussion Preferences pop-up window. 
2. Click the radio button expressing your preference. 
3. Click Update. The window closes with preference displayed when you refresh the page. 
  
Note: If you update your preferences while viewing a message thread, you will need to return to View All 
Threads and re-enter the thread to view the new layout.  

Viewing All Forums 
If your Community Facilitator(s) have created different threads, you can view the entire list of topics posted 
for the Community. 
 
1. From the Community page, click View All Threads. The list displays. If you are viewing a message 

thread, all threads are listed in the Threads box on the left-hand side of the page. 
2. Click a thread’s link to view its messages.  

Viewing a Thread and Reading Messages 
1. To view a specific discussion thread, click its Thread name as listed in the Community Discussion panel 

of the Community page or on the View All Threads page. The Message page displays, with the first 
message of the Thread at the top. Depending on your Preference setting, you will either see all the 
responses below that message or a list of links to the replies. 

2. If your preference was "a single message at a time," click the messages in the threads below the 
original message to view them. Then the new message displays at the top, followed by the remaining 
links in the hierarchy.  

3. If there are additional links below this message, you will see the list of links and a "+" character at the 
left of the message. This means there is more content below the link.  Note: The "+" looks like "±" 
because it is part of the link and is underlined.  

4. To view messages above the current message, click the first linked message.  

Replying to a Message 
Begin at the page with the message to which you are replying: 
 
1. Click Reply link and add your comments. The Reply page displays. 
2. Retain or change the Subject in the Subject field. 
3. Enter your response in the Body field. 
4. Click Post Message. Your reply posts after the previous reply to or under the original message.  
  
Note: Your message position may be at the bottom of the screen if there are many responses to the original 
message.  
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Viewing the Full Thread 
To read a full thread, including Title and Body text:  
 
1. From the Message page, click the View Full Thread link found in the Thread Options box in the 

upper-left corner of the page. The page displays.  

Creating a New Thread 
To create a discussion thread (that is to create a new topic to which other members of the community can 
reply): 
 
1. From the Community page or at any Message page, click the Create a New Thread tab at the top of 

the page. The Create a New Thread displays. 
2. Enter the Subject of your new thread in the subject field. 
3. Enter the body of your message. 
4. Click Post Message. Your new thread is added to the list of threads displayed for the Community.  

Editing Your Message 
As the creator of a thread, you can edit your own message to correct typographical errors, grammar, 
spelling, or to rephrase your thoughts. Do not edit the message after others have responded, since this may 
cause confusion. 

Subscribing to a Thread 
To subscribe to a thread: 
 
1. From any Message page, click the Subscribe to Thread link found in the Thread Options box in the 

upper-left corner of the page.  When you go back to the community home page, the thread will appear 
in the Community Discussions panel under the Subscribed Threads heading. 

Unsubscribing to a Thread 
1. Go to the Thread to which you want to unsubscribe. 
2. Click the Change Thread Subscription link found in the Thread Options box in the upper-left corner 

of the page. 
3. Unclick the Subscribe box. 
4. Click Update Subscription. The thread will be removed from the Community Discussions area on the 

Community Home Page. 
5. Click the Community Home link tab at the top of the page to return to the Community Home Page.  

Printing a Thread 
You can change the formatting of the thread display for printing, showing only the content of each message 
in the thread. 
 
1. From the Message page for the thread, click Printer-Friendly Format. The converted page displays 

and is automatically sent to your printer. 
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Working with CoP Messaging 
SLA's Communities of Practice internal messaging system lets you send messages to other SLA members. 
This feature facilitates your professional communication and preserves your privacy, since Internet e-mail 
addresses aren't necessary within the system. The instructions below explain how to use the various 
features of the system.   
 
Note: You can't communicate with non-members using this system. To contact non-members, use your 
standard email. SLA's internal messaging functionality is similar to standard email.  

Setting Messaging Preferences  
Messaging Preferences allow you to indicate whether or not you want to receive a new Community message 
notification sent to your Internet email address as entered in your Profile and to design an "Out of Office" 
message. To set your messaging preferences, you need to be in the Messaging Center. This page is reached 
from the CoP home page or your Personal Page by clicking the Mailbox icon.  From the Inbox Folder, click 
the Mail Preferences tab found at the top of the page. The Message Preference window opens. 

Sending Notification of New CoP Messages To Your External E-mail Address 

1. Select either the "Yes" or the "No" radio button to determine if you wish to be sent notification to 
your external Internet email that you have received new messages in your CoP mail account. 

2. Click Update to save your choice. The window closes. 

Setting an "Out Of Office" Notice 

To set your CoP Messaging to automatically reply with an "Out Of Office" response:  
 
1. In any email window, click the Messaging Preferences top found at the top of the page. The 

Messaging Preferences window displays. 
2. For the Out of Office option, click Yes. 
3. Type the desired reply message to be automatically sent. 
4. Click Update to save your message. 
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Reading Messages 
When you have new messages waiting, a little red number appears under your mailbox icon at the top of 
your personal page or CoP pages. That number indicates how many unread messages are in your inbox. 

Reading Messages  
1. To access your messages, click the Mailbox icon on the top navigation bar of your personal page or any 

CoP page. A red number indicates how unread messages you have. 
2. Click the message's subject line to open the message. 
3. When you access the message, buttons at the bottom of the message permit you to reply to, forward, 

delete, or move the message:  
a. To reply, click Reply or Reply All. (See Replying to a Message.) 
b. To forward the message, click Forward. (See Forwarding a Message.) 
c. To delete the message, click Delete. (See  Deleting a Message.) 
d. To move the message to a folder, click Move. (See Saving Messages in Folders.) 

4. To return to your inbox, click Inbox.  

Reading Messages in Folders 
1. Click the Mailbox icon on the top navigation bar of your personal page or any CoP page. The screen 

displays your messages window with your Inbox selected. 
2. Click the name of the folder containing messages you wish to access. 
3. Click the message's subject line to read the full message.  
4. When you access the message, buttons at the bottom of the message permit you to reply to, forward, 

delete, or move the message: 
a. To reply, click Reply or Reply All. (See Replying to a Message.) 
b. To forward the message, click Forward. (See Forwarding a Message.) 
c. To delete the message, click Delete. (See Deleting a Message.) 
d. To move the message to a folder, click Move. (See Saving Messages in Folders.) 

5. Click the folder link to return to the folder you have been viewing.  

Viewing/Saving Attachments 
Messages containing attachments are marked with a small paper clip in the Inbox. To access attachments: 
 
1. Open your message. 
2. Either: 

a. Left-click the attachment name. The attachment will open in a new window. 
b. Right-click the attachment name, then save the attachment per your browser instructions. 

3. Click Inbox to return to your Inbox.  

Replying to a Message 
With the message open: 
 
1. To reply to the original sender of a message, click Reply.  To reply to all recipients of the message, click 

Reply All. The Compose window opens. 
2. The address of the sender is automatically entered. If you want to include others in your reply: 

a. To add additional SLA recipients not stored in your personal address book, click Search. 
(See Selecting Recipients from the SLA Database.) 

b. To add SLA recipients stored in your personal address book, click your Address Book. (See 
Adding Recipients from your Address Book.) 

c. To select from an already-created distribution list (group), click List. (See Recipients from a 
Distribution List.) The compose window reopens with the name(s) you have added.  Note: 
To remove a name, click the X icon preceding the name.  

3. Click into the message box and enter your reply. 
4. Click Send Message. The sent message is stored in your Sent Mail folder.  
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Forwarding a Message 
With your message open: 
 
1. Click Forward. The Compose window opens, with "FW:" added to the subject field and Forwarded 

Message added to the Message Body field. 
2. Choose from one or more of the following: 

a. To forward to SLA recipients not saved in your personal address book, click Search. (See 
Selecting Recipients from the SLA Database.) 

b. To forward to additional recipients saved in your personal address book, click Address 
Book. (See Adding Recipients from your Address Book.)  

c. To select from an already-created distribution list (group), click List. (See Recipients from a 
Distribution List.) The compose window reopens with the name(s) you have added.  Note: 
To remove a name, click the X icon preceding the name.  

3. Click Send Message. This action forwards the message and stores a copy in your Sent Mail folder.  

Composing New Messages 
1. Click Create Message tab found at the top of the page to open the Compose window.  
2. Add recipients: 

a. To add recipients from the SLA database, click on Search. (See Selecting Recipients from 
the SLA Database.) 

b. To add addresses from your personal Address Book, click on Address Book.  (See Adding 
Recipients from your Address Book.) 

c. To select from an already-created distribution list (group), click List. (See Recipients from a 
Distribution List.) The compose window reopens with the name(s) you have added.  Note: 
To remove a name, click the X icon preceding the name.  

3. Click in or tab to the Subject field, then type a title for your message. 
4. To add an attachment, click Add Attachment. (See Adding Attachments to Messages.) 
5. Click in or tab to the Message Body field to enter your message content. 
6. Click Send Message. This action sends the message and stores a copy in your Sent folder.  

Adding Attachments to Messages 
As with standard email, you can attach a file to your message. 
 
1. Click Create Message tab found at the top of the page to open the Compose window. 
2. Click the Upload link on the Attachment link. The Add Attachment window opens. 
3. Use the Browse button to navigate to the file on your computer or network. 
4. Enter a brief description to let the recipient what you have attached. 
5. Click Add Attachment. The window closes. 
6. When you've finished composing and addressing your message, click Send Message.  

Addressing Messages 
You may use one of several options to address your messages: 
 

Selecting Recipients from the SLA Database 

To select recipients from the full SLA member database: 
 

1. Click Create Message tab found at the top of the page to open the Compose window. 
2. Click Search. 
3. Enter appropriate keyword information to conduct your search. Note: You can select all SLA 

members in a given state or city by completing only those fields. 
4. Click Search. A list of members matching your search criteria displays. 
5. To add a single recipient, click a name to select it.  
6. To add multiple recipient, click on the checkbox next to each of the intended recipients names and 

then click on the Select Users button. The compose window displays with those name(s) listed 
under the To header.  Note: Click the X icon preceding a recipient's name to delete it. 
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7. Continue to add recipients to the TO, CC, and BCC fields as appropriate. There's no limit to the 
number of recipients you can add.  

Adding Recipients from your Address Book 

Your Address Book should include SLA members whom you contact frequently. Entering names here 
allows you to quickly include them as recipients compared to performing a search of the full SLA 
database. To learn how to add names to your address book, see Adding Names to Your Address Book. 

 
1. Click Create Message tab found at the top of the page to open the Compose window. 
2. Click Address Book on the To, CC, or BCC lines as appropriate.  
3. To add a single recipient from your address book, click a name to select it.  
4. To add multiple recipients from your address box, click on the checkbox next to each of the 

intended recipients names and then click on the Select Users button.   
5. The screen returns to the compose window with the name(s) you have selected now listed under 

the To header.  Note: Click the X icon preceding a recipient's name to delete it.  

Adding Recipients from a Distribution List 

A Distribution List is a pre-assembled group of SLA member addresses to which you send messages with 
a single click. To learn how to create distribution lists, see Creating Distribution Lists. 

 
1. Open the Compose window. 
2. Either: 

a. Click the name of the list that appears in your Address Book box under Lists; or 
b. Click List l in the address line, then click the desired list name.  

3. The Compose window reopens with the names of the list members appearing under the To column.  
Note: Click the X icon preceding a recipient's name to remove it. 

4. Repeat Steps 2-3 wish to include additional Distribution Lists.  
 

Adding Names to your Address Book 
If you e-mail certain members often, you can save time by adding them to your Address Book. 
 
1. Click Add in the Address Book panel. The Add To Address Book window displays. 
2. Search for the name by entering as much relevant information as you have.  Note: You can select all 

SLA members in a given state or city by completing only those fields. 
3. Click Search. A list of members matching your search criteria displays. 
4. To add a single recipient to your address book, click a name to select it.  Your address book displays 

with it added. 
5. To add multiple recipients to your address box, click on the checkbox next to each of the intended 

recipients names and then click on the Select Users button.  Your address book displays with it added.  

Removing Names from your Address Book 
To remove a name(s) from your Address Book:  
 
1. Click Edit found in the header of your Address Book. 
2. Click Remove next to the name you want to delete. The screen refreshes with the name deleted.  

Creating Distribution Lists 
If you send frequently messages to the same group of individuals, you can create a distribution list to save 
yourself time. 
 
1. Begin at any mail screen or at the Inbox screen. 
2. Click the Edit link in the Address Book header. The Address Book window opens. 
3. Click the New List tab found at the top of the page. The Create List window opens. 
4. Enter a name for your list, then click the Create List button. The Address Book window opens, 

displaying the new list at the bottom. 
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5. Click Add Person to List to add names. (See Selecting Recipients from the SLA Database.) The screen 
refreshes after each new name you add.  Note: Click the X icon preceding recipient's name to remove it. 

6. Your list is automatically saved  

Renaming a Distribution List 
1. Click the Edit link in the Address Book header. The Address Book window opens. 
2. Click Rename to the right of the distribution list you want to rename. The Edit List window displays. 
3. Enter the new list name. 
4. Click Edit List. The new name is saved and the Address Book window displays.  

Deleting a Distribution List 
1. Click the Edit link in the Address Book header. The Address Book window opens. 
2. Click Delete to the right of the distribution list you want to delete. The list is deleted and the Address 

Book window displays. 

Deleting a Message 
As with standard email, deleting a message moves it to your Delete folder.  We recommend keeping 
messages in your Trash for 30 days. SLA administrators will periodically delete messages from your Delete 
folder. 

Deleting a Message from the Read Message Page 

1. Select the message by clicking on the subject line. 
2. Click the Delete button at the bottom of the message. This moves the message to the Delete 

folder.  

Deleting from your Inbox or Folders 

1. Begin at your Inbox or any folder. 
2. Click to place a check mark in the Select column for the message(s) you want to delete. 
3. Click Delete. This moves the message to your Delete folder.  Note: Messages are stored in your 

Delete folder for 30, 60, or 90 days depending on administrator settings and are then permanently 
deleted from the system.   

Undeleting Messages  

1. Open the Delete folder. 
2. Click to place a check mark in front of the message(s) you want to undelete.  Note: Use Select All 

button to delete all your messages at once. Or you can singly "unclick" the messages you want to 
keep. 

3. Click Undelete. This moves the message(s) to your Inbox folder.  

Saving Messages in Folders 
You may want to organize your messages in folders by topic or other categories. Here are two methods to 
create folders and move messages into them. 

With the message on screen 

1. Have your message on screen. 
2. Click the down arrow in the Move To drop-down list box and select the folder destination. 
3. Click Move. This moves the message to the selected destination folder.  

With the inbox or another folder on screen 

1. Click the check box next to each message you would like to move into another folder. 
2. Click the down arrow in the Move To drop-down list box and select the folder destination. 
3. Click Move.  This moves the message to the selected destination folder.  
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Creating Folders 
To create folders to help you organize your messages:  
 
1. From any email screen, click New in the Folders panel. The Add Folder window displays. 
2. Enter the new folder name in the Name field. 
3. Click Create Folder. This adds the new folder to the list.  

Renaming Folders 
1. From any email screen, click Edit in the Folders panel. The Folders window displays. 
2. Click Rename next to the folder you want to rename. The Edit Folder window displays. 
3. Enter the new name of the folder in the Name field.  Note: You cannot rename the Inbox, Sent or Delete 

folders. 
4. Click Edit Folder. This renames the folder and returns you to the Folders window.  

Deleting Folders  
CAUTION: Deleting a folder permanently deletes all e-mail messages stored in the folder.   
 
1. From any email screen, click Edit in the Folders panel. The Folders window displays. 
2. Click Delete next to the folder you want to delete. The Edit Folder window displays. This deletes the 

folder and returns you to the Folders window. Note: You cannot delete the Inbox, Sent or Delete folders. 
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Member Search 
It's easy to learn about other members with similar interests, in similar geographic locations or in the same 
unit membership as you--people who can assist you, and who you can assist in turn.  
 
You can easily send CoP e-mail messages directly from your mail search results, so that you can invite other 
members to join a new Community or ask whether they would like to start a new Community with you. 
 
The procedures described below will help you search for and contact SLA members. Begin at your Personal 
Page or any CoP Community page.  Note: Make sure your SLA profile is kept up to date so that the search 
results provided continue to provide accurate information about you.   
 
1. Click the Member Search icon. 

a. To locate a specific individual, enter as much information as you have into the fields at the 
top of the page. 

b. To locate individuals by their unit of membership, select an item from the list box, then 
click Add to move it to the right-side panel.  You may select as many units of membership 
as you like. 

2. Click Search for Members. Your search results display. If you are not satisfied with the search results or 
wish to conduct an additional search, click Search Again.  If a significant number of search results are 
returned, you will be presented with a result count and asked if you would like to proceed or return to 
the previous page to revise your search criteria. 

3. To send an e-mail message to individual members listed in your search results, click the checkbox next 
to their name. To select all members found in your search, click the Check All button towards the top of 
the result list. Click Send Message; the messaging window opens.  If you are unhappy with your 
results, click the Search Again button at the bottom of the window. 

4. For the Subject Panel, click the radio button matching your message subject: 
a. Request to Join a Community 
b. Request to Start a Community  
c. Network 
d. Custom--If you select Custom, click into the text field to enter your message subject. 

5. Enter the text of your message in the Message field.  
6. Click Send Message.  The message is sent and you are returned to your Personal Page. Note: if you 

click Cancel, you'll need to use your browser's Back button to return to the search page. 
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My Profile 
Your SLA member profile is used to store contact and other information you provide. The Update Profile link 
lets you update your member profile information. Your profile is used in the Communities of Practice so that 
members can identify you as an individual they'd like to work with or get to know.  Note: As of the writing of 
this Users Guide, CoP profiles are not updated in the SLA membership database.  Please let SLA know if 
changes need to be made to your first or last name, or e-mail account.  
 
To verify and update your profile: 
 
1. From your Personal Page, or from any CoP page, click the My Profile icon. The Edit My Profile page 

displays. 
2. Review the information you see, or enter your first name, middle name, last name, and external email 

addresses in the corresponding text fields.  
3. Review the information you see in the About Me text box. To enter or update information, click into the 

text field and enter any information you think members would find valuable to know about you (work 
history, job title, special areas of interest, accomplishments, personal information and so forth). 

4. You can add a photo of yourself to your profile. This photo should be in .jpg or .gif format optimized for 
web display. Maximum file size is 40K; maximum display size is 300 pixels by 300 pixels. Recommended 
display size is 150 pixels wide by 180 pixels high.  

a. Click Browse to navigate to your photo file on your computer, then click Open. The file will 
upload. 

5. When you're satisfied with your profile, click Update. Your Profile is saved. 
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Join/Visit Communities 
Join/Visit Communities lets you search for Communities of interest to you based on a keyword search and 
then lets you visit or choose to join a Community. To review all communities, use the scroll bar of your 
browser to view the entire list. 

Searching for Communities 
1. From your Personal Page or any community home page, click the Join/Visit Communities icon. The 

Join or Visit Communities page displays. 
2. Since may be are many active communities, you can narrow the list by entering keyword(s) in the 

Search Unsubscribed Communities text field, then clicking Search. The list of unsubscribed 
communities that meet your criteria displays.  

3. You can also search for communities using the alphabetical Index. 
a. Click View All to see all the communities that are available. The list appears, including a 

link to the community, its description, the number of members, when it was last updated, 
and a checkbox to select to join the community. 

b. Click a letter of the alphabet to see the communities starting with that letter to which you 
have not subscribed. The list appears, including a link to the community, its description, the 
number of members, when it was last updated, and a checkbox to select to join the 
community.  If you are already a member of a community, the Join check box will not 
appear. 

4. You can either visit or join a community, as described below. Click Personal Home to exit the page.     

Visiting Other Communities 
1. Using your search result list, click on the name of the community.  The Community Page opens.  When 

visiting a community, you will only be able to view information listed on the Community home page.  
The View All and Suggest links will not appear in any of the headers.  To participate in a community you 
must first join that community. 

2. Click your browser Back button to return to the Join/Visit Communities page or click on the Join/Visit 
Communities icon at the top of your screen. 

Joining Communities 
1. Place a check mark in the Join checkbox to the right of one or more communities. 
2. Click Join Communities at the bottom of the page.  The screen displays a confirmation. 
3. Click the Personal Home tab found at the top of the page to return to your Personal Page.  The 

community will now be listed in your My Communities panel.  
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Unsubscribing from Communities 
To remove yourself from the membership of any of your communities: 
 
1. From your Personal Page or from any Community page, click the Unsubscribe icon. The Unsubscribe 

from Communities page displays. 
2. Place a check mark in the Unsubscribe checkbox to the right of any community from which you wish to 

unsubscribe. 
3. Click Unsubscribe. The community(s) will no longer be listed in your My Communities panel. 
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Suggesting a New Community 
If you can't find the community you're looking for under the View All list, use this function to request that a 
new Community be formed. 
 
1. Click the Suggest a Community icon on the Top Navigation Bar or the Suggest a Community link in 

the header of the My Communities panel. The Suggest A Community window displays.  
2. Click into the fields provided to describe the Community you want to request. Try to be explicit as you 

describe the benefits your Community would provide to SLA members. 
3. Provide one or more keywords to help potential members locate the Community in a search.  
4. Answer the Facilitator Questions.   

 
Note: Before a new community can be created, at least one facilitator must oversee activities.   
 
As the person suggesting the new Community, you're the most obvious person to serve as Facilitator, or 
you may know someone who would like to serve. Facilitators are SLA members who volunteer to 
support and champion the success of a particular Community. These volunteers monitor activity within 
the Community, encourage member participation, and organize Community events (virtual or face-to-
face). Duties of a facilitator include:  

 
• Starting discussions  
• Polling Community members 
• Updating content 
• Ensuring members' questions are answered  
• Coordinating member communications  
• Identifying and using experts 
• Scheduling and hosting chat sessions  
• Managing and organizing Community resources  
• Planning Community events beyond the virtual community 

 
5. Click the down arrow of the drop-down list box and select the name of any Community to which your 

new community might be related. 
6. Provide other relevant information that would help the SLA staff in reviewing your request in the text 

field below.  
7. Click Submit Suggestion. SLA staff reviews all suggestions for appropriateness and to avoid redundant 

communities. You will be notified of their decision.  
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CoP Central: The SLA Community 
CoP Central, or the SLA Community, is the community of all SLA members. Visit to learn the latest news, 
find resources, and discuss issues affecting SLA as a whole. To access the SLA Community main page: 
 
1. Click the CoP Central icon. The CoP Central page displays.  
2. For instructions on using the features on this page, see the help provided in Community Pages.  
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Returning to Your Personal Page 
Click the My Personal Page icon on the Navigation Bar from any Community page to return to your 
Personal page.   
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Getting Help 
If you have questions about using this site, you can click on the site-specific Help links or click the FAQ link 
found at the top of all web site pages in the purple bar. If you'd like additional help or wish to report a 
problem, use the Virtual Help Desk. 

Virtual Help Desk Log On 
1. To log on: 

• If you are already registered for help desk access, enter you user name and password in the fields, 
then click Logon. 

• If you have forgotten your password, click E-mail My Password. It will be sent to you. 

Creating a New Help Desk Username and Password 
1. If you are new to the Help Desk click New User. The Registration for New Users screen appears, shown 

below.  
2. Fill in the fields as requested. You may omit the phone number and location fields. Click Submit. 
3. You will receive a confimation notice that an account has been created. Now you can log on using the 

link at the bottom of the message.   

To Edit Your Information 
1. Clicking Edit Information takes you to the Update Information screen. Here you can edit the 

information you entered as a New User and change your password. 
2. Click Submit to complete your updates. 

The SLA Virtual Help Menu 
The SLA Virtual Help Desk Menu offers you the options of submitting a problem, searching the knowledge 
base, and updating your Help Desk profile. (If you have already submitted a problem and it's been assigned 
a number, you can enter the number in the text field to the left of the Open specific ID button or the Lookup 
by ID button.)  

Submitting a New Problem 

1. You may wish to click View Problem List and read the problems and solutions, so that you don't 
submit a duplicate issue.  

2. Once you've determined that your issue is new, click Submit New Problem. The Submit a New 
Problem displays. 

3. If you have created a login, your contact information automatically populates. If not, fill in the fields 
as appropriate. 

4. Use the drop-down list boxes to the right to classify your problem.  Select the appropriate 
Department (for example, Technology Services) from its drop-down listbox. Then select the 
appropriate problem category (for example, E-mail issues) from its drop-down listbox, shown below. 

5. Key in a short description of your topic/problem in the Title field. 
6. Use the Message field to provide details of your topic or problem. 
7. Click Submit Problem to send your problem to the Help Desk. To start over, click Clear Form. 

Search the Knowledge Base 

1. From your Personal Page or any Community page, click the Help icon. The SLA Virtual Help login 
screen displays.  

2. Click Search the Knowledge Base. The Knowledge Base screen displays, shown below.  
3. Enter a keyword which describes the subject you wish to learn more about.  
4. Click on or off the Title, Description, and Solution checkboxes depending upon where you want to 

search. 
5. Click Search. Any problem and solution which fit your search will display.  
6. Click the title of the item (for example to read the problem and solution). 
7. Either click Menu to reach the problem submission menu or click Log Off to exit the Virtual Help 

Desk. 
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